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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the service provider AT&T Mobility in Puerto Rico and Avaya IP
Office 8.0.

The AT&T Mobility in Puerto Rico SIP Trunk Service provides PSTN access via a SIP trunk
between the enterprise and the AT&T network as an alternative to legacy analog or digital
trunks. This approach generally results in lower cost for the enterprise.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.

MAA; Reviewed: Solution & Interoperability Test Lab Application Notes 1 of 31
SPOC 6/14/2012 ©2012 Avaya Inc. All Rights Reserved. ATT PR _IPOS



1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the service provider AT &T Mobility in Puerto Rico and an Avaya IP
Office solution.

In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500v2
Release 8.0, Avaya Voicemail Pro, Avaya IP Office soft clients and Avaya desk phones,
including SIP, H.323, digital, and analog endpoints.

The Avaya IP Office system can be configured to authenticate with the SIP service provider
using either SIP Trunk Registration or Static IP Authentication. These Application Notes cover
the configuration of IP Office using SIP Trunk Registration, and the use of the Digest
Authentication method for the validation of the calls flowing from the Enterprise to the PSTN,
via the AT&T Mobility in Puerto Rico SIP Trunk Service.

The AT&T Mobility SIP Trunk Service referenced within these Application Notes is designed
for business customers. The service enables local and long distance PSTN calling via standards
based SIP trunks as an alternative to legacy analog or digital trunks, without the need for
additional TDM enterprise gateways and the associated maintenance costs.

In the following pages, and for brevity in these Application Notes, the service provider’s name
“AT&T Mobility in Puerto Rico” will be abbreviated and referred to as “AT&T Mobility” or just
“AT&T”.

2. General Test Approach and Test Results

A simulated enterprise site was configured in the test lab using Avaya IP Office, connected to the
AT&T Mobility SIP Trunk Service by means of a SIP trunk over the public Internet. This
scenario may differ from a real customer environment in Puerto Rico, in which a dedicated
private network connection could be provided by AT&T to the customer site.

The configuration shown in Figure 1 was used to exercise the features and functionality tests
listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.
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2.1 Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e SIP trunk registration to the network.

e Response to SIP OPTIONS queries.

e Incoming PSTN calls to various phone types. Phone types included SIP, H.323, digital
and analog telephones at the enterprise. All inbound PSTN calls were routed to the
enterprise across the SIP trunk from the service provider.

e Authentication of calls made from the Enterprise to the PSTN.

e Outgoing PSTN calls from various phone types. Phone types included SIP, H.323,
digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from soft clients.

e Various call types including: local, long distance, international, outbound toll-free,
emergency (911) and directory assistance (411 and 611).

e Codecs G.729A and G.711MU.

e (aller ID presentation and Caller ID restriction

e DTMF transmission using RFC 2833

e Voicemail navigation for inbound and outbound calls

e User features such as hold and resume, transfer, and conference

e Off-net call forwarding and twinning

e Use of the SIP REFER method as an alternative approach to performing call forwarding
and call transfer of inbound calls back to the PSTN.

e T.38 Faxing.

Items not supported or not tested included the following:
e Operator services such a dialing 0 or 0 + 10 digits are not supported in this offer by
AT&T in Puerto Rico.
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2.2. Test Results

Interoperability testing with AT&T was completed with successful results for all test cases with
the exception of the observations/limitations described below:

e At the time of writing this App Notes, for incoming calls that are forwarded back to the
PSTN via the SIP trunk, IP Office will automatically insert the IP address of its LAN2
interface in the host portion of the Diversion header sent to the service provider. Since
AT&T required the use of domain names on requests arriving to their network, including
Diversion headers, these calls were rejected. This does not happen with other types of
calls using Diversion headers, like twinned calls, where the header is built based on the
entry on the “ITSP Domain Name” field in the SIP Line tab. A workaround to this
situation is not to use the Diversion header at all in the IP Office, setting the “Send caller
ID” entry in the SIP Line tab to “None”. By setting this, calls that are forwarded from the
IP Office back to the SIP trunk are allowed to complete, with the constraint that the caller
ID shown in the receiving end of these forwarded calls will be that of the host extension
in the IP Office, not the originator caller ID. This limitation will also affect twinned calls.
An issue report was opened with IP Office Development for investigation.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on the AT&T Mobility SIP Trunk Services offer, call the AT&T Mobility
Network Operations Center in Puerto Rico at 787-717-9900.
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3. Reference Configuration

Figure 1 below illustrates the test configuration. It shows the enterprise site connected to the
AT&T SIP Trunk Service through the public IP network.
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Figure 1: Test Configuration

Note that for security purposes, all public IP addresses and phone numbers shown throughout
these Application Notes have been edited so that the actual IP addresses of the network elements
and public PSTN numbers are not revealed.

The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM64 (Voice Compression Module) for supporting VoIP
codecs. The LAN1 port of Avaya IP Office is connected to the enterprise LAN while the LAN2
port is connected to the public IP network. Endpoints include Avaya 9600 Series [P Telephones
(with H.323 firmware), Avaya 1140E IP Telephones (with SIP firmware), Avaya 1408 and
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9508D Digital Telephones, analog telephones, Officejet 4500 fax machines and PCs running
Avaya IP Office Softphone and Avaya IP Office Phone Manager as SIP and H.323 soft clients,
respectively. The site also has a Windows XP PC running Avaya IP Office Manager to configure
and administer the Avaya IP Office system, and Avaya Voicemail Pro providing voice
messaging service to the Avaya IP Office users. Mobile Twinning is configured for some of the
Avaya IP Office users so that calls to these users’ extensions will also ring and can be answered
at the configured mobile phones.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the Avaya IP Office system, such as a session
border controller or data firewall. A complete discussion of the configuration of these devices is
beyond the scope of these Application Notes, however, it should be noted that SIP and RTP
traffic between the service provider and the Avaya IP Office system must be allowed to pass
through these devices.

Since Puerto Rico is a country member of the North American Numbering Plan (NANP), the
users dialed 10 digits for local calls, and 11 (1 + 10) or 10 digits for other calls between the
NANP.

4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Component \ Version
Avaya
Avaya [P Office 500v2 8.0 (42)
Avaya IP Office Digital Expansion Module 10.0 (42)
DCPx16
Avaya IP Office Manager 10.0 (42)
Avaya IP Office Voicemail Pro 8.0(1009)
Avaya 9620 IP Telephone (H.323) Avaya one-X Deskphone Edition 3.1
Avaya 9640 IP Telephone (H.323) Avaya one-X Deskphone Edition 3.1
Avaya 1140E IP Telephone (SIP) 04.03.09.00
Avaya Digital Telephone 1408 N/A
Avaya Digital Phone 9508 N/A
Avaya IP Office Softphone 3.1.2.17 59616
Avaya IP Office Phone Manager 4.2.39
AT&T Puerto Rico SIP Trunking
Acme-Packet Net-Net 4250 SBC Firmware SC6.1.0 MR-9 GA (Build 938)
BroadWorks Soft Switch R17
Nortel CS2K PSTN Gateway CVM11
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5. Configure IP Office

This section describes the Avaya IP Office configuration necessary to support connectivity to the
AT&T Mobility SIP Trunk Service. Avaya [P Office is configured through the Avaya IP Office
Manager PC application. From the PC running the Avaya IP Office Manager application, select
Start - Programs - IP Office > Manager to launch the application. Navigate to File >
Open Configuration, select the proper Avaya IP Office system from the pop-up window, and
log in with the appropriate credentials. A management window will appear similar to the one
shown in the next section.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this section, the View menu was configured to show the Navigation pane on
the left side, the Group pane in the center and the Details pane on the right side. These panes will
be referenced throughout the Avaya IP Office configuration.

Standard feature configurations that are not directly related to the interfacing with the service
provider (such as LAN interface to the enterprise site, Twinning and IP Office Softphone
support) are assumed to be already in place, and they are not part of this Application Notes.

5.1. Licensing

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity, click License in
the Navigation pane and SIP Trunk Channels in the Group pane. Confirm that there is a valid
license with sufficient “Instances” (trunk channels) in the Details pane. Note that the actual
License Key in the screen below was edited for security purposes.

License

IP Offices

SIP Trunk Channels

License Type -
W IPSO0 Yoice Metworkin

o 8 BOOTP (4)

Licenses |
Operator (3)

----- <2 Contral Unit (53
----- 4 Extension (45)
----- : User (47}

----- 4§ HuntEroup (1)
----- @ sShort Code (63)

----- i Account Code (0)
----- W License (74)

----- i Tunnel (0)

----- i3 User Rights (&)
..... "¢ ARS (1)

e IPgec Tunnelling

S Mobility Features

R Office Warker

% onie-¥ Portal For TP OFF
% Phone Manager Pro
% Phone Manager Pro (p

""" @ Service (0) % Phone Manager Pro IP
---- g IRAS m Call Route (4) S Power User
e neoming Al Route % Preferred Edition (Yoic
----- B8 wanPart (0} - -
- % Preferred Edition Addit
- Direckory (0) -
;’I*\ Time Profile (0) -PreFerred,l'Advanlced ke
_____ @ Fireweall Profils (11 % Proactive Reporting
..... El I Route (3) R RAS LRO Support (Rap

% Receptionist

S Report Yiewer

% SIP Trunk Channels
%= Small Office Edition ¥C
% Small CFfice Edition Wil

IPSO0YZ Main License Key IXthHeﬁbQDXHZ_
--3) Syskem (1) % Microsoft CRM Integra
_____ 17 Line (19 & Mohile Woarker License Tyvpe ISIP Trunk Channels

License Status I'v'alid

Instances |255

Expiry Date |Never
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5.2. LAN2 Settings

In the sample configuration, IP500V2 Main was used as the system name, and the WAN port was
used to connect the Avaya IP Office to the public network. The LAN2 settings correspond to the
WAN port on the Avaya IP Office. To access the LAN2 settings, first navigate to System (1) 2>
IP500V2 Main in the Navigation and Group panes and then navigate to the LAN2 = LAN

Settings tab in the Details pane. Set the IP Address field to the [P address assigned to the Avaya

IP Office WAN port. Set the IP Mask field to the mask used on the public network. All other
parameters should be set according to customer requirements.

IP Offices System

ﬁ

IP500V2 Main®

R EOOTP (4)

Mame
= IPS00YZ Main
LAMN Settings |\-'DIP I Nebwark Topalogy |

Syskem | LamM1  LANZ |DNS I Yaoicemail I Telephaony | Directory Services I Systemn Events I SMTP I SMDR

-2y System (1)
- Line (19)

= Control Unit (5)
-4y Extension (45)
: User (47}
-;;! HurkGroup (13
- @3 Short Code (63)
-8 Service (0)
oy RAS (1)
e Incoming Call Route (43
- ¥F) WarPort ()
--am Direckory (0)
f’.“ Tirne: Prafile (07
@ Firewsall Profile (13
- [fll TP Route (3)

-l Accounk Code (00

IP Address

IP Mask

Primaty Trans. IP Address

172 . 16 . 1 . 15

[es5 . 285 . 255 . 192

[0 .0 .0 .0

Firewall Profile I ZMone j
RIP Mode [raoe =l
I Enabls naT
Murmber OF DHCP IP Addresses lﬁ
DHCP Mode
|7(" Server { Client € Dialn % Disabled Advanced |

On the VoIP tab in the Details pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks. The RTP Port Number Range can be customized to a specific
range of receive ports for the RTP media. Based on this setting, Avaya IP Office would request
RTP media be sent to a UDP port in the configurable range for calls using LAN2.

=) IPS00V2 Main

LA&M Sektings ~ WoIP |Netw-:urk Topaology |

System | LamMl  LAME |DNS | Yaicernai | Telephony | Direckary Services | Swstem Events | SMTP

[ H.z23 Gaatekeeper Enable
¥ SIP Trunks Enable

[ =p Registrar Enable

[ H.323 suto-create Extn

[T H.323 Auto-create User

Enable RTCP Maonitoring
[
v On Pork 5005

RTF Pork Mumber Range

Port Range (Minimum) ~ [49152

Pork Range (Maximunm’) |53246

kb 1

[ H.323 Remate Extn Enable
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Avaya IP Office can also be configured to mark the Differentiated Services Code Point (DSCP)
in the IP header with specific values to support Quality of Services policies for both signaling
and media. The DSCP field is the value used for media and the SIG DSCP is the value used for
signaling. The specific values used for the compliance test are shown in the example below.

In the RTP Keepalives section, set the Scope field to RTP, and Initial keepalives to Enabled.
This will cause the IP Office to send RTP keepalive packets at the beginning of the calls, to
avoid problems of media deadlock that can occur with certain types of forwarded calls that are

routed from the IP Office back to the network, over the same SIP trunk.

—DiffSery Settings

. a

BE == DSCP(Hex) |FC DSCP Mask (Hex) |38 =] SIG DSCP (Hex)

|46 5: DSCF |63 5: DSCP Mask 34 = S5IGDSCP

—DHCP Settings

Primary Site Specific Option Murmber (S50M) 178 =
Secondary Site Specific Option Mumber {SSOMN) |242 ﬁ
YLAN [not Present 7]
1100 Yoice YLAK Site Specific Option Mumber (S50 |232 :I

1100 Voice YLAN IDs |

—RTP Keepalives

Initial keepalives IEnaI:uIe-:I - I

SCope RTP * | Periodic timeout IU

All other parameters should be set according to customer requirements.

MAA; Reviewed: Solution & Interoperability Test Lab Application Notes
SPOC 6/14/2012 ©2012 Avaya Inc. All Rights Reserved.

9 of 31
ATT PR_IPOS



On the Network Topology tab in the Details pane, configure the following parameters:

e Seclect the Firewall/NAT Type from the pull-down menu to the option that matches the
network configuration. No firewall or network address translation (NAT) device was
used in the compliance test as shown in Figure 1, so the parameter was set to Open
Internet. With this configuration, the STUN Server IP Address and STUN Port are not
used.

¢ Sect Binding Refresh Time (seconds) to 780. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTION messages to the service
provider.

e Sect Public IP Address to the IP address that was set for LAN2.

e Set Public Port to 5060.

e All other parameters should be set according to customer requirements

= IP500V2 Main

System | LamM1  LAMZ |DNS | Yaicemail | Telephiomy | Directory Services | Systemn Events | SMTP | SMDR,

L& Settings| yoIP  Metwork Topalogy |

—Mebwork Topology Discowvery

STUM Server IP Address [ 69 . 90 . 168 . 13 STUIM Part |34?3 =
Firewall/MAT Twpe IOpen Internet j

Binding Refresh Time 180 -

(zeconds) =

Public TP Address [172 . 16 . 1 .18

Public Park ISDEEI E: Fum STUMN Zancel

™ Run STUM an skarkup

For the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site [P network. The LANT1 interface configuration is not directly relevant to the
interface with the AT&T SIP Trunk Service, and therefore is not described in these Application
Notes.
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5.3. Voicemail

On the Voicemail tab in the Details pane, configure the parameters on the SIP Settings section.

This is necessary if remote n

otification features such as Callback and Outcalling are enabled, and

outbound calls from the IP Office Voicemail system are to be routed on the SIP trunk. The
values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From and Contact headers for outgoing SIP trunk calls from the Voicemail. They were set to

one of the DID numbers assi

gned by AT&T. The SIP Display Name (Alias) parameter can

optionally be configured with a descriptive name. Uncheck the Anonymous box. All other

values used for the complian

IP Offices System

K BOOTP (4) Name
% Operator (3) 5 IPS00Y2 Main
¢ IPSO0YE Main
= System (1)
-4 Line (19}

<2 Control Unit {5}
Ay Extension {48)
g User (47}
- a HunkGroup (1}

i

ce test are shown in the screen below.

= IP500V2 Main

System | Lant | Lanz | DHs  Voicemal |Te\ephony | Directory Services | System Events | sMTR | sMOR | Twinning | vem | ccr

Woicemail Type IVoicemaiI LitefPro j r Messages Button Goes To Yisual Yoice
Voicemail Destination I j

‘oicemail IP Address 192 . 165 . 10 150

Backup Yaoicemail IP Address o a 1} o

— Yoicemail Channel Reservation

- @ Short Code (64)
-8 Service (0) Unreserved Channels  [259
2 |
iy RAS (1
.. g Incon&ilig Call Route (43 Auko-Atkendant ID 33 ‘oice Recording ID 33 Mandatory Yoice Recording |0 :I
- Eﬂ “WanPark (0} = p -
..o Directory (0] AnnoUNCEments ID 3. Mailbox Access ID 3.
£47 Time Profile (0) —DTMF Breakout
- @ Firewall Prafile {1}
-l TP Route (3) Reception | Breakout (DTMF *0/0) I
il Account Code (0)
e Licores (74) Breakaut (DTMF 2) |
@ Tunrel (0) Breakout (DTHF 3) |
-§q User Rights (8)
- ARS (1) —SIF Settings
- RAS Location Request {1
. gg E211 System (1) SIP Mame I?B?l 111234
SIP Display Name (Alias) |Voice Mail
Contack I?S?l 111234
Anonymous r
—Call Recording
Auto Restart Paused Recording (secs) |15 3:
Hide Auto Recording r
: iewed: uti Jo . .
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5.4. System Telephony Settings

Navigate to the Telephony = Telephony Tab in the Details Pane. Choose the Companding
Law typical for the enterprise location. For North America, ULAW is used. Uncheck the Inhibit
Off-Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via
the SIP trunk to the service provider.

IP Offices System E IP500V2 Main £

Name
R goortp @) ——————— Systaml LANL I LaNZ | DM | voicemail  Telephony |D|rectory Ser\ncasl Syskem Eventsl SMTR I SMDR I Twmnlngl WiCM | CCR I Codecs
Operator (3) "=/ IPSO0VE Main
IPSO0YZ Main Telephoriy |TDI‘IES & Music | Call Log I
’I:‘ iﬁ:z‘;gl) Analogue Extensions Companding Law
1

=+ Control Unit {5)

Swiitch Line
N Default ©utside Call Sequence INnrma\ Vl
-y Exkension (45) e P
@ User (47) Default Inside Call Sequence IRing Type 1 'l @ Wz @ UHalie
= 13 HunkGroup (1)
. Default Ring Back Sequence IRln Type 2 'l
@) short Code (63) g Q g Typ ol  Alapine

3 @ Service (0) Restrict Analogue Extension Ringer Yoltage [
ally RAS (1)
5 @ Incoming Call Route (4) Dial Delay Time (secs) [~ 0S5 Stakus

= @ witanPort (07 ! s
s Direckory (0) Dial Delay Count o 3: ¥ guto Hold
£ Time Profile (0) =
@ Firewall Profile (1) Default Mo Answer Time (secs) 15 3 ¥ | Dial By Mame
B 1P Route (3)
B Account Code (0)

120 3:
- License (74) Park Timeout (secs) 300 3: I™ Inhibit Off-Switch Farward,Transfer
5 32

Hold Timeout {secs) ¥ Show Account Code

i Tunnel (0)
™ Restrict Metwork Interconnect

- ; 4 User Rights () Ring Delay (secs)

AR () Call Priority Promotion Time (secs) | Cisabled 33 I Drop External Only Impromptu Conference
- RAS Location Request {0}

- gx E911 System (1) Default Currency usD - ™ wisually Diffsrentists External Cal

Default Hame Priarity Fawor Trunk -I ™ Unsupervised Analag Trunk Disconnect Handling

¥ High Quality Canferencing

5.5. Twinning Calling Party Settings

Navigate to the Twinning tab on the Details Pane. Uncheck the Send original calling party
information for Mobile Twinning box. This will allow the Caller ID for Twinning to be
controlled by the setting on the SIP Line (Section 5.8). This setting also impacts the Caller ID
for call forwarding.

IP Offices IP500%2 Main

BOOTR (4) flare System | LANL | LaM2 | DMS | vaicemail | Teleph Directary Sarvi Systam Events | SMTP | SMDR
Operator (3) o PEO0YZ Main yE emI | | | DICEITI&II Elep onyl IFECCOFY Er\-’lCESl WSCEM VEHSI |

IPSO0YE Main I Send original calling party infarmation Far Mobile Twinning

Calling party information For I
Mobile Twinning

v Contral Unit {5)

e i a
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5.6. System’s Default Codec Selection

Select the Codecs tab in the Details Pane. The list of Available Codecs shows all the codecs
supported by the system, and those selected as usable. The Default Codec Selection area enables
the codec preference order to be configured on a system-wide basis. The buttons between the two
lists can be used to move codecs between the Unused and the Selected lists, and to change the
order of the codecs in the Selected codecs list. By default, all IP (SIP and H.323) lines and
extensions will use this system default codec selection, unless configured otherwise for a specific
line or extension.

=] IP500V2 Main

Mame . . o 0 P
% 1PS00VZ Main Syskem I LAM1 | LAMNZ | DS I ‘oicemail I Telephony I Directory Services I System Events | SMTP I SMOR I Twinning | WiCM | CCR Codecs |

—vailable Codecs r—Default Codec Selection

—Unused ——————— —Selected
G711 LILAW 69K = G711 LLAW 89K
G711 ALAW E4K E'if?(ﬁigfvﬁ?CELp
O .72z e4k '
G.723.1 6K3 MP-MLQ
G.729() 8K C5-ACELP 2

35.723.1 K3 MP-MLO

£

S ARE]

5.7. IP Route
Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets, in order to reach the SIP proxy subnet on the AT&T network. On the left
navigation pane, right-click on IP Route and select New.

e Set IP Address and IP Mask of the remote AT&T SIP Proxy subnet.

e Set Gateway IP Address to the [P Address of the router used to reach the external

network. For the test configuration, this was the IP address of the local ISP router.
e Set Destination to LAN2 from the pull-down menu.

B 10.1.1.0 - X v«
IF Route |
IP Address Jio 1 1 0
IP Mask [es5  zs5 zm5 . 0
Gateway IP Address I 172 . 16 . 1 . 254
Drestination JLanz |
Metric Jo =

r Proxy ARF
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5.8. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the AT&T SIP

Trunk Service. To create a SIP line, begin by navigating to Line in the Navigation Pane. Right-

click and select New— SIP Line. On the SIP Line tab in the Details Pane, configure the

parameters as shown below:
e Set the ITSP Domain Name to the domain known and expected by the Service Provider.
IP Office will use this domain as the host portion of the SIP URI in SIP headers of the
messages sent to the network.
e Check the In Service box.
e Check the Check OOS box. With this option selected, I[P Office will use the SIP
OPTIONS method to periodically check the SIP Line.

Set Call Routing Method to Request URI.

Set Send Caller ID to None, as the workaround to the Diversion header problem
described in Section 2.2.

Check the REFER support box. Select Always for both Incoming and Outgoing to
enable the IP Office to send REFER headers for transferred and forwarded calls that are
routed back to the PSTN.

e Default values may be used for all other parameters.

IP Offices Line B SIP Line - Line 17
& BOOTR (4) 'f_elN“mber :;'F:IEZT SIP Line: ITransportISIP URI|valr |38 Fax|SIP Credertials|
%+ Operatar (3) ¢
g IPSO0V2 Main 2 PRIZI|  Line Number |1? =

-y System (1) w17 SIP Li
..... 17 Line (19 7201 analg | ISP Domain Marne |aslab.centi><voip.net In Service I~
----- <2 Contral Unit (5) 4202 Analo

) L Use Tel URT I
----- A8y Extension (47) 4203 Analol
""" % User (47) " 204 Analg | Prefi [ Check 005 W~
----- e HunbGroup (1 F3205 Anald
----- gé Short Co(d)e (63) T_‘: 206 anald Iational Prefix IU Call Routing Method IRequest LRI j
----- Sevice (0 - i

F4z07 Analol Criginator number for

..... ol RAS (1) Fo08 Al Country Code I Farwarded and twinning calls I

) T4
g i:;onll?lonr? (CD‘;" Route 1209 analo|  International Prefix IUD Mame Priority ISystem Default j

T
e Directory (00 T_' 210 Analy Send Caller ID INone j
£ Time Profile {0} Tj 2l Anald
_____ @ Firewall Profile {13 ;j212 Analoy Association Method IBy Source IP address j
T
..... B 1P Route (3 § _,213 Analo ¥ REFER Support
----- mm fccount Code (my (| TH214 Analo
..... &, License (74) tHz215 Analol[ | Incaming |-°'lwavs =l
..... @ Tunnel (D) 216 &naloy )
Cukgoin Always <
----- g“ User Rights () e I ¥ J
----- " AR 1Y
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Select the Transport tab and set the following:

e Set the ITSP Proxy Address to the IP address of the AT&T proxy server.
e Setthe Layer 4 Protocol to UDP.

e Set Use Network Topology Info to LAN2 as configured in Section 5.1.

e Set the Send Port to 5060.

e Default values may be used for all other parameters.

W

= SIP Line -Line 17

1P Line Transport |stp LR1|vatp | 738 Fax| stP Credentiaks]

ITSP Proxy Address [10.1.1.25

Metwork Configuration

Layer 4 Protacol |uDF | sendport [sos0 =
IUse Metwark Topalogy Info IL.ﬂ.I"-J z j Listen Paork ISEIE-EI ::I
Explicit NS Server(s) [0 . 0 . 0 . 0 [0 .0 .0 .0

Calls Route wia Registrar W

Separake Regiskrar I

MAA; Reviewed: Solution & Interoperability Test Lab Application Notes 15 of 31
SPOC 6/14/2012 ©2012 Avaya Inc. All Rights Reserved. ATT PR _IPO8



SIP Credentials must be created for the Digest Authentication scheme used by AT&T for the
SIP trunk registration and the authentication of calls made from the enterprise to the PSTN.

Every outbound REGISTER or INVITE request sent from IP Office is initially rejected by
AT&T, with an error code “401 Unauthorized”. This message from the service provider also
contains a challenge or “nonce”, which in conjunction with the SIP credentials previously
supplied by AT&T are used by IP Office to generate a new request by means of an MDS5 hash
algorithm. This request, containing a newly generated Authorization header with the proper
authentication credentials and response to the “nonce”, is sent to AT&T and is then accepted and
processed accordingly.

To create a SIP Credentials entry, first select the SIP Credentials tab. Click the Add button and
the New Channel area will appear at the bottom of the pane. For the compliance test, a single
SIP credential entry was created with the parameters shown below:

e Set User name, Authentication Name and Password to the values provided by the
service provider.

e Leave the Registration required option checked, since the SIP trunk will need to
register with the AT&T SIP Trunk Service.

e Use the default value of 60 minutes, in the Expiry field. The actual registration
expiration time is negotiated and agreed upon as part of the registration exchange.

Ei SIP Line - Line 17
SIP Line| Transport | SIP URI|volP | T38 Fax SIP Credentials |
Index | serMame | Authentication MName | Conkack | Expity (mins) | Regisker | add,,.
1 FEPI111235 7871111235 &0 True
Remove
Edit. ..

— Edit SIP Credentials

User name |?8?1 111235 K |

Authentication Name |7B71111235 Canicel
Zonkack I
Passwaord I*******
Expiry (rnins) 60 -
Reqistration required v
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A SIP URI entry needs to be created to match each incoming number that Avaya IP Office will
accept on this line. To create a SIP URI entry, first select the SIP URI tab. Click the Add button
and the New Channel areca will appear at the bottom of the pane. For the compliance test, a
single SIP URI entry was created that matched any number assigned to an Avaya IP Office user.
The entry was created with the parameters shown below.

B SIP Line - Line 17 k- X v <>

SIP Line| Transpart STP URI |votp | 736 Fax| SIP credentisis|

Set Local URI, Contact and Display Name to Use Internal Data. Set PAI to None.

For Registration, select 1:7871111235 from the pull down menu. This matches the SIP
credentials previously created on the SIP Credentials tab.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Default values may be used for all other parameters.

channel | Groups | wia | Local uri | contact | Display Mame | Pad [ credential | max calls | &
1 7 17 B.. .. 1:787L... 10
Edit Channel
x|
WA

Local LRI | Canvcel
Contact [Use Intemal Bata =
Display Mame [Liz= Intermal Caka =l
P [Here =
Resgistration 1: FETI111Z35 -
Incoming Group ll?i
Qutgaing Group |W7
Maox Calk per Chamel -]
MAA; Reviewed: Solution & Interoperability Test Lab Application Notes 17 of 31

SPOC 6/14/2012 ©2012 Avaya Inc. All Rights Reserved. ATT PR _IPOS



Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e Inthe sample configuration, the Codec Selection was configured using the Custom
option, allowing an explicit ordered list of codecs to be specified, different from the
system default defined in Section 5.6. The buttons allow to set an explicit list of codecs
to be used on the line, in that specific order of preference.

e For Fax Transport Support, select 738 Fallback. With this setting, outgoing fax calls
will use T.38 transport, but under certain error conditions a re-invite is sent to connect at
G711 pass-through. Incoming audio calls that detect fax tones also initiate fax transport
using T38 Fallback.

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

e Uncheck the VolIP Silence Suppression box.

e Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on
the trunk.

e Check the PRACK/100rel Supported box, to advertise the support for provisional
responses and Early Media to AT&T.

e Default values may be used for all other parameters.

o

SIP Line - Line 17

SIP Line | Transport| SIP LRI YoIP |38 Fax| SIP Credentials|

Codec Seleckion ICustom j I™" voIP Silence Suppression

—Unused ——————————— —Selected ——————— ¥ Re-invite Supparted

G711 ALAW 64K = G.729(a) 8K C5-ACELP
G, 7231 6K3 MP-MLQ G711 ULANY 6k

™ Use Offerer's Preferred Codec
™ Codec Lockdown

. ¥ PRACK!100re] Supported

S

SR ]

Fax Transport Support |T38 Fallback. ﬂ
Call Initiakion Timeout (s) |4 3:
DTMF Support [rFczaas |

Since default values were used on the T38 Fax tab, this tab will not be visited.
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5.9. Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.8. To configure these settings, first navigate to User in the left
Navigation Pane, and then select the name of the user to be modified in the center Group Pane.
In the example below, the name of the user is Extn 1101dcp. Select the SIP tab in the Details
Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI
in the From and Contact headers for outgoing SIP trunk calls. In addition, these settings are used
to match against the SIP URI of incoming calls without having to enter this number as an explicit
SIP URI for the SIP line (Section 5.8). The example below shows the settings for user
“Extnl1101dcp”. The SIP Name and Contact are set to one of the DID numbers assigned to the
enterprise by AT&T. In the example, the DID number 7871111236 was used. The SIP Display
Name (Alias) parameter can optionally be configured with a descriptive name.

B Extn1101dcp: 1101

‘foice Recording I Eutton Programming I Menu Programming I Mobility | Phone Manager Cptions I Hunt Group Membership I Announcements  S1P

IP Offices

- R BOOTP (4)
Lg% Operator (3)
IPS00YZ Main

§ Extniinidep
§ Extni10zdep SIF Mame [ra71111238
§ Extnlioadep
§ Exniios SIP Display Mame (Alias) [Extnl101dep
§ Extniios
§ Estniios
§ Extnitor
2 Extnll03 ™ anonymous
£

5 System (1)

T4 Line (19)

<2 Control Unit ()
-y Extension (48]
2 User (47)

1# HuntGroup {13
@3 Short Code (64)

Conkact I?S?l 111236

5.10. Incoming Call Route

Incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc, within the IP Office system. Incoming call routes should be defined for
each DID number assigned by the service provider, matching incoming numbers on the SIP line
with defined destinations in IP Office

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in IP
Office. The routing decision for the call is based on the parameters configured for Call Routing
Method and SIP URI (Section 5.8) and the users SIP Name, already populated with the
assigned AT&T DID numbers (Section 5.9)

From the left Navigation Pane, right-click on Incoming Call Route and select New.

On the Details Pane, under the Standard tab, set the parameters as show bellow:
e Set Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.8.
e Default values may be used for all other parameters.
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IP Offices

-~ K BOOTP (4)

Lire Group ID

Incoming C...

o
-

Incarmin

i Operator (3) @o

-5 IPSO0YE Main @D
45 System (1) O
-4 Line (19) @17

-2 Control Unit (5)
-y Extension (47)
@ User (47}

i Hunt&roup (1)
@ Short Code (63)
@ Service (0}

% RAS (1)

-~ Incoming Call Rou
Eﬁl WanPort (00
--amm Directory (0)
f.x‘ Tirme Profile {0}
{8} Firewall Profile {1°

Bearer Capability

Lire Group ID
Incoming Mumber
Incoming Sub Address
Incoming LI

Locals

Pricrity

Tag

Hold Music Source

Standard |\.|'|:|i|:e Recording I Destinations I

17
I.ﬁ.n';-' Waice j
fi7 =l
|
|
|
| -
|1 - Law j
|
ISystem Source j

e Under the Destinations tab, enter “.” for the Default Value. This setting will allow the
call to be routed to any destination with a value on its SIP Name field, entered on the
SIP tab of that User, which matches the number present on the user part of the incoming

Request URL.
= 17 B~ X | v | <=
Standard | Yoice Recording  Destinations |
TimeProfile Destination Fallback Extension
> Default Yalue ﬂ j
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5.11. Short Code /Automatic Route Selection
Define a short code to route outbound traffic to the SIP line. To create a short code, right-click
on Short Code in the Navigation Pane and select New. On the Short Code tab in the Details
Pane, configure the parameters as shown below.
e Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 8V;. This short code will be invoked when the user dials 8
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N”@aslab.centixvoip.net”. This field is used to construct the
Request URI and To headers in the outgoing SIP INVITE message. The value N

represents the number dialed by the user. The domain name used by the AT&T SIP proxy
server during the compliance test follows the @ sign in the above expression.

e Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.8. This short code will use this line group when placing
outbound calls.

e Default values may be used for all other parameters.

P Office 0 pcle E BN.DlaI
R BOOTR (4] rode Telephor 2| short code |
“gi Operatar (3) Bz N
-3y IPSO0YZ Main PR N Code ISNJ
55 System (1) s -
7 Line (19) e Feature IDlaI ﬂ
-2 Contral Unit (S} 7 #u Telephaone Mumber IN"@asIab.centixvoip.net"
e Extension (48) n*1g
g user (47) BX+19 Line Group ID Il?f j
-:a HuntGroup {13 BREz0Rmg N p "
X ShDrF Code (64) T Locale IUnlted States (LS English) ﬂ
- B Service (0 oo Force Account Code [~
@ ?AS (1) Call Route (4) B30
- Incoming Call Route o

Optionally, Automatic Route Selection (ARS) can be used rather than the simple short code
approach described above. With ARS, secondary dial tone can be provided after the access code,
time-based routing criteria can be introduced, and alternate routing can be specified so that a call
can re-route automatically if the primary route or outgoing line group is not available. ARS also
facilitates a more granular treatment for different types of calls, and permits a more specific
matching of the telephone number dialed following the access code. While detailed coverage of
ARS is beyond the scope of these Application Notes, and alternate routing was not used in the
reference configuration, this section includes some basic screen illustrations of the ARS settings
used during the compliance test.
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To create a short code to be used for ARS, right-click on Short Code in the Navigation Pane and
select New. The screen below shows the short code 9N created. Note that the semi-colon is not
used here. In this case, when the Avaya IP Office user dials 9 plus any number N, instead of
being directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which is
configurable via ARS.

Short Code |

Code |9N

Feature IDiaI j

Telephone Mumber IN

Lime Group I ISEI: Main j
Locale ILInited Skakes (115 English) j

Force Account Code [

The following screen shows the example ARS configuration for the route Main. Note the
sequence of Xs used in the Code column of several entries to specify the exact numbers of digits
to be expected, following the access code and the first digit on the string. For example, for local
calls in Puerto Rico, the user dialed 9, then 10 digit numbers starting with a 7. This type of
setting results in a much quicker response in the delivery of the call by the IP Office. Also note
that the AT&T domain name does not need to be specified in the Telephone Number field of
the entries. It is automatically inserted by IP Office in the outbound SIP-URI, using the value
from the ITSP Domain Name field, entered in Section 5.8.

IP Offices ARS B Main ef 1
R BOOTP (4) .Name Time Profile RS |
Operatar (3) “ ¢ Main
¢ IPSO0Y2 Main AR5 Rodte Id 50 v Secondary Dialtone ————
-y System (1)
- Line (19) Raute Marme [1zin SystemTone 'I
-y Conkral Unik {53
-~y Extension (48) Dial Delay Time System Default (4) 33 ¥ check User Call Barring
: User (47)
ﬂ HunkGroup {13
@ Short Code (64) In Service v Out of Service Route I<Nune> j
@ Service {0)
<y RAS (1) |
Q Incoming Call Rouks (4)
@ WanPart (1) Tirme: Profile: <Mone:= 7 | m—— Qut of Hours Route |<None> j
@ Directory (0)
"f‘ Tirne Prafile (0) l
@ Firewall Profile (1) -
1P Route (3) Code | Telephone Mumber | Feature Line Group ID | Add...
.. Account Code (0) a1 Dial Emergency 17
- W License (74) 911 Dial Emergency 17 ﬂl
& Tuninel (0) ¢ Edit...
- User Rights () LA, 1M Dial 17 —I
- ARS (1) DRHHHERRH R aK Dial 17
- RAS Location Request (1 411 411 Dial 17
- E911 System (1) 611 611 Dial 17
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5.12. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling
party number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively. Avaya IP Office can be configured to use the P-Preferred-Identity
(PPI) or P-Asserted-Identity (PAI) header to pass the actual calling party information for
authentication and billing. By default, Avaya IP Office will use PPI for privacy. For the
compliance test, PAI was used for the purposes of privacy.

To configure Avaya IP Office to use PAI for privacy calls, navigate to User = NoUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

IP Offices

R BOOTP (4)

% Operator (3)
= IPS00YZ Main
-5y System (1)
..... T Line (15}
..... <2 Control Unit (5)
..... Ay Extension (43)
..... § User (47
----- ﬂ HuntGroup (1)
..... B short Code (64)
..... B service (0)

----- A BAS 1Y

User

[ame
§rsoft s1P 1550

§rsoft Hazs 1595
§ spisao
§rsipisTe
§rsipisTs
§rsipisTz
frsipis7t
frsipisTo
; RemoteManager

=

User | Yaicemail | DD I ShartCodes  Source Numbers |Telephony | Faorwarding I Dial In | Voice Recording

Source Mumber I

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_USE_PAI FOR _PRIVACY. Click OK.

Mew Source Mumber
|7 Siource Mumber

SIP_UUSE_PAL_FOR_PRIVACY

QK |
_concel |

Cancel

The SIP_USE_PAI_FOR_PRIVACY parameter will appear in the list of Source Numbers as

shown below.

s Operator (31
[=--5=p IPSOOYZ Main

IP Offices User
-~ R BOOTP (4) hame =

& soft SIP 1550
§ 5oft Hazs 1595

.59 System (1) § sipisan SIP_IISE_PAI_FOR_PRIVACY
..... 1 Line (19 :v'rsip15?6
----- <2 Control Unit (5) §rsip1ses
----- Ay Extension (48) =v-r5ip15?2
----- i User(47) Frsin1571
----- ﬂ HunkGroup (1) =,..-5ip15;rg
..... g Shart C!Ed)e (64) ;RemoteManager
----- Service |0
g Mol
..... M pas it i e

User | Yaicemail | DMD | ShartCodes  Source Mumbers |Telephony I Farwarding | Dial In | Yoice Recording|

Source Mumber |

5.13. Save Configuration
Navigate to File = Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections (not shown).
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6. AT&T Mobility SIP Trunking Configuration

AT&T Mobility in Puerto Rico is responsible for the configuration of the AT&T SIP Trunk
service. The customer will need to provide the IP address used to reach the Avaya IP Office at
the enterprise site. AT&T will provide the customer the necessary information to configure the
Avaya IP Office SIP connection to AT&T including:

e [P address of the AT&T SIP Proxy server.

e AT&T SIP domain name.

e Supported codecs.

e DID numbers.

e Username and password to be used for SIP Credentials.

e All IP addresses and port numbers used for signaling or media that will need access to the
enterprise network through any security devices.

7. Verification Steps

The following steps may be used to verify the configuration:
e Use the Avaya IP Office System Status application to verify the state of the SIP
connection. Launch the application from Start > Programs - IP Office
- System Status on the PC where Avaya [P Office Manager was installed. Log in
using the appropriate credentials and select the SIP line of interest from the left pane. On
the Status tab in the right pane, verify that the Current State is Idle for each channel
(assuming no active calls at present time).

ﬂVAyA IP Office System Status

Snapeheot  LogOff  Exk About

Slalus  Ubkestion Summsry Alwrms  Registrabon

SIP Trunk Summary

Pear Domain hame: aslsh. capbovoip nst
Fesodved Address: 10.1.1.25
4 '"""'" - Lire hmber: L7
Humber of Admwnstered Channel: Lo
Humber of Charnels in Lss: [
Sdministered Compresson; ar29 A, a1l My
Sdenae Suppresson; off
SIF Trunk Channel Licensss: Unbmisd . e
SIP Trunk Channel Licensss in Use: i
SIF Dereiom Festures: REFER, {[ncoming ard Cutgong )

ihannsl LRI Cal Temain  Remobs odec Correc.,. Caller [0 Ckher Parbyon Dweckion  Bound
Humber G, Rl Staba Skt Ciala, ,, of Call TripDw.,. Miear

3 Pl Y | dary 2
L] e |1 a2
5 L

[ Id= 1 day 2,
7 e |Lday 2,
[ M |1dsy 2
E e |1dsy 2
10 e |Ldaya
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAyA IP Office System Status

Help  Snapshat  LogQff  Exit  About

System

& Alarms (6)

Extensions (27)

Trunks (19)
Line: 1
Line: 2

Status  Utilization Summary Alarms Reqistratian

filarms for Line: 17 SIP aslab.centixvoip.net

OCCUrrEnces Error Descripkion

»
Lines: 201 - 216
Active Calls
Resources
Voicemail
IP Hetworking

e Seclect the Registration tab and verify that the user name used in the SIP credentials for
the SIP line has a Status of Registered.

IP Office System Status

Tatus  Llation Suminary

Registration Status

TEM111235 Registersd A0 127544 P

e Verify that a phone connected to Avaya IP Office can successfully place a call to the
PSTN with two-way audio.

e Verify that a phone connected to the PSTN can successfully place a call to the Avaya IP
Office system with two-way audio.

8. Conclusion

These Application Notes describe the procedures required to configure SIP trunk connectivity
between Avaya IP Office 8.0 and the AT&T Mobility in Puerto Rico SIP Trunk Service, as
shown in Figure 1.

AT&T Mobility in Puerto Rico SIP Trunk Service passed compliance testing. Interoperability
testing of the sample configuration was completed with successful results for all test cases with
the exception of the observations/limitations described in Section 2.2.
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9. Additional References

[1] IP Office 8.0 Installation Manual, Document Number 15-601042, March 2012

[2] IP Office Manager Manual 10.0, Document Number 15-601011, April 2012

[3] IP Office Release 8.0 Implementing Voicemail Pro, Document Number 15-601064,
December, 2011

[4] IP Office System Status Application, Document Number 15-601758, November 2011
[5] Avaya IP Office Knowledgebase, http://marketingtools.avaya.com/knowledgebase/

Product documentation for Avaya products may be found at http://support.avaya.com.
Product documentation for AT&T Mobility SIP Trunk Service is available from AT&T
Mobility.

Appendix: SIP Line Template

Avaya IP Office Release 8.0 supports a SIP Line Template (in xml format) that can be created
from an existing configuration and imported into a new installation to simplify configuration
procedures as well as to reduce potential configuration errors.

Not all of the configuration information is included in the SIP Line Template, therefore, it is
critical that the SIP Line configuration be verified/updated after a template has been imported,
and additional configuration be supplemented using Section 5.8 in these Application Notes as a
reference.

To create a SIP Line Template from the configuration described in these Application Notes,
configure the parameters as described below.

To enable template support, select File, then Preferences. On the Visual Preferences tab, check
the Enable Template Options box.

il IP Office Manager Preferences [ 2] I
Preferences | Directaries | Discovery Yisual Preferences |53curity | '-.-'aliu:latiu:unl
Ican
S ISmaII j

™ multiine Tabs
¥ Enatle Template Cptions
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To create a SIP Line Template from the configuration, on the left Navigation Pane, right click
the Sip Line (17), and select Generate SIP Trunk Template.

IP Offices SIP Line - Line 17
BOOTP (4) Lie Mumber [ L2 T tp Line |rranspart| 51p URI| valP |38 Fax| P Credentias|
Operator (3) # 1 PRI 24
2 PSO0VE ] hew vy 7 B
43P Sys —
- fE ]  Generate SIP Trunk Templake slab. centixvoip.net In Service v
i cu el Lise Tel LRI I
3 Copy Chr+C Check 005 v
Past Chrly
] e i Call Routing Method IRequest URI j
75 Delete ChrDel Originator number For I
W Validate forwarded and twinning calls
) Mame Pricrit Syskern Default ~
Connect Tou.. Cel+T ¥ I Y J
one &
Shows In Groups J
v Source IP address j
Custornize Columns.,..
= R ErTHppTTT
----- #m Account Code (0} T2 Analo
----- 8. License (74) 218 Analo Incorming Jalways =
----- W& Tunnel (09 Tiz16 Analo )
Outgain Always =
----- §5 User Rights (8) B I i J

The trunk’s settings are displayed as configured in Section 5.8. Enter a descriptive name for the
template, adjust the settings if required, and then click on Export.

il SIP Trunk Template - {SIP Trunk - 17)

FPlease review and change the trunk zettings if you want -

SIF Line | Transpnrtl 4alP I T38 FaHI SIF Credentialsl

Degcriptive Mame I.-’-‘«T&T FR IPO2 Use Tel URI -

ITSP Damain Marme Iaslab.centiwnip.nel Check 00S v

Send Caller 1D INone j Call Routing Method IHequesl LRI ﬂ
Azsociation Method IBy Source IP address ﬂ %?ﬂgﬂgégﬂ;ﬁﬁirﬂng calls I

Refer Suppart v Marmne Friarity ISystem Default j

REFER Support
Inzaming I.&Iways j
Outgaing I.&Iways ﬂ
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On the next screen, Template Type Selection, select the Country, enter the name for the
Service Provider, and click Generate Template.

| il Template Type Selection N [=]
Locale | Urited States (US English] =l
Countm IF'uertu:u Rico j
Service Provider [ATET Mobiliy |
Generate Template | Cancel

The following is the exported SIP Line Template file PR_AT&T Mobility SIPTrunk.xml:

<?xml version="1.0" encoding="utf-8" ?>

- <Template xmIns="urn:SIPTrunk-schema">
<TemplateType>SIPTrunk</TemplateType>
<Version>20120430</Version>
<SystemLocale>enu</SystemLocale>
<DescriptiveName>AT&T PR IPO8</DescriptiveName>
<ITSPDomainName>aslab.centixvoip.net</ITSPDomainName>
<SendCallerID>CallerIDNone</SendCallerID>
<ReferSupport>true</ReferSupport>
<ReferSupportIncoming>1</ReferSupportIncoming>
<ReferSupportOutgoing>1</ReferSupportOutgoing>
<RegistrationRequired>false </RegistrationRequired>
<UseTelURI>false</UseTelURI >
<CheckOOS>true</CheckO0S>
<CallRoutingMethod>1</CallRoutingMethod>
<OriginatorNumber />
<AssociationMethod>SourceIP</AssociationMethod>
<LineNamePriority >SystemDefault</LineNamePriority >
<ITSPProxy>10.1.1.25</ITSPProxy>
<LayerFourProtocol>SipUDP </LayerFourProtocol >
<SendPort>5060</SendPort>
<ListenPort>5060</ListenPort>
<DNSServerOne>0.0.0.0</DNSServerOne>
<DNSServerTwo>0.0.0.0</DNSServerTwo>
<CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
<SeparateRegistrar />
<CompressionMode>AUTOSELECT </CompressionMode >
<UseAdvVoiceCodecPrefs>true</UseAdvVoiceCodecPrefs>
<AdvCodecPref>G.729(a) 8K CS-ACELP,G.711 ULAW 64K</AdvCodecPref>
<CallInitiationTimeout>4</CalllnitiationTimeout>
<DTMFSupport>DTMF_SUPPORT_RFC2833</DTMFSupport>
<VoipSilenceSupression>false</VoipSilenceSupression>
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<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP_T38FB</FaxTransportSupport>
<UseOffererPrefferedCodec>false</UseOffererPrefferedCodec>
<CodeclLockdown>false</CodecLockdown>
<Rel100Supported>true</Rel100Supported>
<T38FaxVersion>3</T38FaxVersion>
<Transport>UDPTL</Transport>
<LowSpeed>0</LowSpeed>
<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate_14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues >true</UseDefaultValues >
<ScanLineFixup>true</ScanLineFixup>
<TFOPEnhancement>true</TFOPEnhancement>
<DisableT30ECM>false</DisableT30ECM>
<DisableEflagsForFirstDIS >false </DisableEflagsForFirstDIS >
<DisableT30MRCompression >false</DisableT30MRCompression>
<NSFOverride>false</NSFOverride>
<SIPCredentials>
<Expiry>60</Expiry >
<RegistrationRequired>true</RegistrationRequired>
</SIPCredentials>
</Template>
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To import the template into a new IP Office system, copy and paste the exported xml template
file to the Templates directory (C:\Program Files\Avaya\IP Office\Manager\Templates) on the
PC where IP Office Manager for the new system is running.

Next, import the template into the new IP Office system by creating a new SIP Line as shown in
the screenshot below. In the Navigation Pane on the left, right-click on Line then navigate to
New, New SIP Trunk From Template:

IP Offices SIP Line -Line 17

R BOOTP (4) L tumber | 02 T\ 51 tine |yansport| stp LRI | verP | 738 Fax| stP credentials|
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----- @ short Raste S Call Routing Method
""" @B Servic| /4 Delete Chrl+Cel Criginakor number For
----- iy RAS(  Walidate forwarded and bwinning calls
""" e Incam Mame Priarity
----- Eﬁl AP Conneck Ta.,. Chr+T
i Direch =] j
..... 7 Time B Show In Groups
..... @ Firew m——— Fource IP address j
_____ IF Ro uskomize Columns. . :

On the next screen, Template Type Selection, verify that the information in the Country and
Service Provider fields is correct. If more than one template is present, use the drop-down
menus to select the required template. Click Create new SIP Trunk to finish the process.

ﬁ Template Type Selection M= E3 |

Locale | Urited States [US English] =

Country

Service Provider |AT&T Mability | I Display A

Create new SIP Twnk | Cancel
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Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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